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1. เริ่มตน NodeMCU 
 

เนื้อหาประกอบดวย 

 ทําความรูจัก NodeMCU 

 การใช Arduino IDE กับ NodeMCU 

 ทดลองเขียนโปรแกรมอยางาย 

 

การเขียนโปรแกรมกับบอรด NodeMCU เปนส่ิงท่ีไมเหมือนกับการเขียนโปรแกรมกับคอมพิวเตอร เราใชเขียนการทํางาน

กับบอรด น้ี เพียงเพ่ือควบคุม การรับ-สงขอมูลของเซ็นเซอรตางๆ เพื่อประมวลผลในพฤติกรรมตางๆ ในความจํากัดของ

ทรัพยากร ที่มีมากกวา คอมพิวเตอรท่ัวไป แตขอจํากัดน้ี ก็มีขอดี คือ เล็ก ใชพลังงานไฟฟานอย ราคายอยเยา แตขอเสียคือ เรา

ไมอาจจะทําให NodeMCU ประมวลผลรูปภาพได เราทําไดแคงานเล็กๆ นอย ในการรับ-สงขอมูลพื้นฐานเทานั้น การทํางานท่ี

หนักกวาน้ัน จําเปนตอเชื่อมกับอุปกรณอ่ืน ๆ แตการประมวลผลในระดับนี้ ก็จําเปนสําหรับงานพ้ืนฐาน เชน การควบคุม การ

ปด-เปด อุปกรณอิเล็กทรอนิกส ซ่ึงนําไปใชทํางานไดหลากหลายในชีวิตประจําวัน ไมวาจะเปนการ ใหเปดกลองวงจรปด เร่ิม

ทํางาน เม่ือมีผูบุกรุกเขาพื้นท่ีตรวจสอบ แลวสงขอมูลไปยังอินเตอรเน็ต การตรวจสอบความช้ืน แสง เพื่อการเปด-ปดนํ้า ในการ

ดูแลตนไม และอ่ืนๆ ท่ีจะประยุกตใชได  
 

รูจัก NodeMCU  

 NodeMCU เปนบอรด Open Source/Hardware มี เฟรมแวร (firmware) เปนฮารดแวรท่ีบรรจุซอฟตแวร ช่ือ 

ESP8266 เปนชิปสนับสนุนการทํางานการตอเชื่อม WiFi อยางสมบรูณ ปจจุบันกลายเปนบอรดคอนโทรลเลอร ไดรับความ

นิยมกันมาก เน่ืองตัวมีขนาดเล็ก ท่ีมาพรอมกับ WiFi และกระแสการใชงานแบบ IOT ทําใหบอรด NodeMCU ตอบสนองความ

ตองการไดพอดี การตอเช่ือมกับคอมพิวเตอรก็ใช สาย miniUSB ซ่ึงเปนแบบเดียวกับท่ีใชงานกับโทรศัพทสมารทโฟนท่ัวไป 

 NodeMCU มีหลายรุน เชน รุน 0.9 หรือเรียกวา V1 กับ 1.0 หรือเรียกวา V2 สองรุนมีขนาดท่ีตางกัน แตท่ีเหมาะ

กับใชงานกับ บอรดขนมปงมากกวา คือรุน 1.0 เพราะมีพื้นท่ีเหลือใหตอขยายได ในขณะท่ีรุน 0.9 ใชเต็มพื้นท่ีบอรดขนม

ปง นอกจากน้ีมี อีกรุนหน่ึงคือ V3 มีขนาดใหญกวา ซ่ึงผลิตโดยบริษัท Lolin แตยังคงมีพิน เหมือนกับรุน 2 
 

 
รูป 1. NodeMCU v0.9 กับ NodeMCU v1.0 

ท่ีมา http://www.cnx-software.com/2015/10/29/getting-started-with-nodemcu-board-powered-by-esp8266-wisoc/ 
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ตาราง 1 รุนของ NodeMcu 

NodeMcu V1 V2 V3 

WiFi Module ESP-12 ESP-12E ESP-12E 

USB to Serial CH340 CP2102 CH340 

ขนาด เล็ก กลาง ใหญ 
 

อินพุท / เอาทพุท 

พินหรือขา ตางๆ ของ NodeMCU ใชเปนแบบ GPIO (General Propose Iinput/output) เม่ือเทียบใชงานกับ บอรด 

Arduino UNO จะมีขาท่ีไมตรงกัน แตใชเทียบกันได เชน Pin 13 ของ Arduino จะมีคาเทากับ ขา D7 ของ NodeMCU, ขา 

12 ของ Arduino จะมีคาเทากับ ขา D6 ของ NodeMCU เปนตน เราดูการเทียบ ขา ตางๆ จากรูปท่ี 2  

ระบบการใชไฟฟา การทํางานของขาตางๆ ทํางานกับไฟฟาแรงดัน 3.3 โวลต แตกับ ขา Vin ท่ีรับไฟฟาแรงดัน 5 โวลต 

เชนเดียวกับ ตอกับสาย miniUSB ท่ีมีแรงดันไฟฟา 5 โวลต 

นอกจากน้ียังมี LED build-in เทียบไดเปน D0 หรือ GPIO16 สามารถนํามาทําทดสอบ LED โดยไมตองมี LED มาตอเพิ่ม

ก็ได และยังมี LED อีกตัวหน่ึงท่ีแสดงสถานการณอัพโหลด 

 
รูป 2 ขาของ NodeMCU V3 แจงในรูป GPIO   (ท่ีมา: www.TheEngineeringProjects.com) 

 

Arduino IDE (Arduino IDE - Arduino Integrated Development Environment)1 

 การเขียนโปรแกรมกับ NodeMcu ใชตัวพัฒนาเปน Arduino IDE ซ่ึงเปนโปรแกรมพัฒนาท่ีใชกับบอรด อารดูโน แต

เน่ืองดวยเปนโปรแกรมพัฒนาท่ีใชงานงาย นักพัฒนา NodeMcu จึงเลือกใช โปรแกรมพัฒนานี้ดวย ภาษาท่ีใชเขียนเรียกวา C 

– Arduino  

                                                             
1 ดาวนโหลโปรแกรม Arduino IDE ไดท่ี https://www.arduino.cc 
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โปรแกรม Arduino-IDE เรียกกันวา Sketch การติดตั้งสําหรับ ระบบปฏิบัติการ Windows  มีใหเลือกแบบไฟล 

Installer ซ่ึงติดต้ังอัตโนมัติ ในระหวางติดตั้งไฟลน้ี จะมีการถามใหลงไดเวอรตางๆ หลายคร้ังใหตอบตกลง และ Zip ไฟล เรียก

ทํางานผาน ไฟล arduino.exe อาจตองติดต้ัง Driver เอง ซึ่งจะมีมาดวยกับท่ี ดาวนโหลด (ดูท่ี Folder Driver)  
 

 
รูป 3. Arduino IDE 

 

ติดตั้ง ไลบาร่ี NodeMCU กับ Arduino IDE 

 การใชงานกับ NodeMCU ไดจะตองติดต้ังไลบรารี เพื่อทํางานไดกับ Arduino IDE ใหเลือกไปท่ี File> Preferences 

ภายในหนาตาง Preferences น้ีใหเลือก Additional Boards Manager URLs: ซ่ึงลางสุดของหนาตางน้ี ใหใส URLวา 

“http://arduino.esp8266.com/stable/package_esp8266com_index.json” จากน้ันกด OK 

 

 
รูป 4 ติดต้ัง ไลบรารี่ ใชงานกับ NodeMCU 
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 เม่ือติดต้ังแรก Arduino IDE จะตองดาวนโหลด ไดรเวอรบอรด จากไลบรารีอางอิง ท่ีสรางกอนหนาน้ี โดยการเลือก 

Board Manager แลวใหเลื่อนหา esp8266 เพ่ือทําการติดตั้ง (คลิก More Info และเลือก รุนลาสุด แลวติดต้ังโปรแกรม) 

เม่ือติดต้ังแลว จะข้ึนขอความวา INSTALLED ดังรูปตอไปน้ี 
  

 
รูป 5 esp8266 Library ท่ีติดติดต้ังแลว 

 

แตเม่ือดาวนโหลดมาพรอมแลว จะพบบอรดใหเลือก ตามรูปตอไปน้ี เปน NodeMCU 1.0 (ESP 12E Module) และเลือก 

Port ในท่ีน้ีเลือก Port 9 แตละเคร่ืองจะพบ Port ท่ีตางกันสามารถตรวจสอบไดท่ี Control Panel > System > Device 

Manager กรณีท่ีไมเห็น Com Port ท่ีใชกับ NodeMCU ใหไปดาวนโหลดมาติดต้ังเองไดท่ี 

https://www.silabs.com/products/development-tools/software/usb-to-uart-bridge-vcp-drivers 
 

 
รูป 6 เลือก Board: “NodeMCU 1.0(ESP-12E Module)” 
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รูป 7 COM Port 

 

เม่ือติดต้ังแลว ทดลองสํารวจตัวอยางโปรแกรมมากมาย ใหไปท่ี Arduino IDE แลวเลือก File > Examples > 

ESP8266 ซ่ึงสามารถทดลองใชงานได  
 

 

รูป 8 ตัวอยางโปรแกรมของ ESP8266 
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เร่ิมตน Hello, World 

 เพ่ือเปนกําลังใจในการใชงานคร้ังแรก ก็เหมือนกับการเขียนโปรแกรมภาษาคอมพิวเตอรอ่ืนๆ ท่ีมักเร่ิมตนเขียน

โปรแกรมแรก ท่ีเรียกวา Hello world ให เขียนโปรแกรมทักทายกัน เปนการเขียนผาน Arduino IDE แลวลงโปรแกรมท่ี

เขียนน้ีไปยังบอรด NodeMcu โดยยังไมตองตออุปกรณอิเล็กทรอนิกสอ่ืน ดวยการทําตามลําดับการทดลองตอไปน้ี 
 

1. ตอเชื่อม USB ของ อารดูโน กับ Computer 

2. เปดโปรแกรม Arduino IDE ตรวจสอบ การตอเชื่อม อารดูโน กับ อารดูโน IDE  

เชน Tool> Port “9” ซึ่งแตละเคร่ืองได Port ไมตรงกัน ใหตรวจสอบท่ี Device Manager ใน Control panel > 

System ใหดูท่ี Ports(Com & LPT) จะพบ คําวา Silicon Labs CP210x USB to UART Bridge (COM9) 

 
3. เขียนโปรแกรม ดังน้ี 

 

void setup() { 

  // Initiate serial communication 

  Serial.begin(9600);//baud rate :9600 bit per second 

} 

void loop() { 

  Serial.println("Hello");   

} 

 

4. กดปุม Upload ใหสวนโปรแกรมน้ี ไปทํางานท่ี บอรด NodeMcu แลวรอผล จะมีสถานะวา Done uploading   

 
5. ตรวจสอบ การทํางาน  

Tools > Serial Monitor  
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ซ่ึงจะไดผลคือ 

 
 

โครงสรางโปรแกรม 

 จากท่ีไดทดลองเขียนโปรแกรม ของปฏิบัติการ 1 จะเห็นวา โครงสรางโปรแกรม จะมีสองฟงกชัน คือ  

1. setup( ){ 

} 

ในสวนฟงกชันน้ี จะมีพ้ืนท่ีใหเขียนโปรแกรม อยูคูของปกการ ฟงกชันน้ีจะเปน กําหนดคาเร่ิมตน ของโปรแกรมท่ีจะ

ใชทํางานท้ังหมดของระบบ Arduino เชน กําหนด Serial.begin(9600) เปนกําหนดวา ใหมีสงขอมูลในระดับ 9600 

บิท ตอวินาท่ี การทํางานสวนน้ีจะทํางานเพียงคร้ังเดียว ตอนเร่ิมตนโปรแกรมเทาน้ัน 

2. looo( ) { 

} 

ในสวนน้ีจะโปรแกรมจะทํางาน วนซํ้าไมรูจบ จนกวา ปดโปรแกรม การทํางานของอุปกรณอิเล็กทรอนิกส เราจะให

ทํางานตลอดเวลาอยูแลว ในการทดลองท่ีผานมา ใหพิมพคา Hello ตลอดเวลา  
 

กรณีท่ีตองการ เขียนคําอธิบาย เพื่อความเขาใจในภาษาท่ีเราเขาใจไดงาย โดยไมมีสวนเก่ียวของกับการทํางานของ

โปรแกรม เราสามารถใชเคร่ือง “//” นําหนาได ทําใหท้ังบรรทัดน้ันถูกขามไป  
 

บอรดขนมปง  

กอนท่ีตอวงจรอิเล็คทรอนิกส เราตองรูจัก บอรดขนมปง หรือ เรียกวาอยางเปนทางการวา Solderless breadboard 

แตบางคร้ังอาจไดยินบางคนเรียกวา Solderless หรือบางคนก็เรียกวา Breadboard ตัวบอรดน้ีเราจะใชเชื่อวงจรไวดวยกัน 

แนวเสนสีเหลือง (ดูรูปท่ี 9) จะเปนจุดท่ีใชเช่ือมตอกัน  สังเกตวา แนวนอน เปนแนวยาว จะเชื่อมตอกันหมด หมายความวา ถา

เราใชสายไฟ ตอในจุดใดก็ไดของแนวนอน จะถือวาเช่ือมตอกันอยู เชน เดียวกับแนวต้ัง จะตอจุดใดของแนวต้ังก็ถือวาเช่ือมตอ

กันหมด ดังเราไมควรอยางยิ่งท่ีจะตอผิด เพราะจะทําใหบอรด NodeMCU เสียหายได 
 

 
รูป 9. แนวการตอเชื่อม ของบอรดขนมปง (Breadboard) 
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สรางหลอดไฟ LED กระพริบ 

มาถึงตอนน้ีก็พรอมแลว ท่ีจะทําลองโปรแกรมเร่ิมตนอยางงาย โดยใช NodeMCU ใชเปนอุปกรณเปด-ปด LED ของ 

NodeMCU ใช D7 (GPIO13) แต ขาท่ัวไปของ Arduino ใชขาท่ี 13 

 
รูป 10 NodeMCU ตอกับ LED 

Code 1.  

const int LED_D7 = 13;//Or D7 

 

void setup() { 

pinMode(LED_D7, OUTPUT); 
 

} 

void loop() { 

  digitalWrite(LED_D7, HIGH); 

  delay(1000); 

  digitalWrite(LED_D7,LOW); 

  delay(1000); 

 

} 
 

 จากตัวอยางโปรแกรมน้ี จะเห็นวา โครงสรางโปรแกรม ยังคงเหมือนเดิม แตมีสวนกําหนดคาคงท่ี ซ่ึงใชคียเวิรดวา 

const เรามักใชคียเวิรดนี้กําหนดคาท่ีไมตองการเปลี่ยนแปลงใดๆ ตลอดการทํางานของโปรแกรมท่ีทํางาน ช่ือตัวแปร LED_D7  

สําหรับคาคงท่ีเปนธรรมเนียมปฏิบัติจะใช อักษรตัวใหญหมด ซ่ึงก็เหมือนกับภาษาเขียนโปรแกรมคอมพิวเตอรอื่นๆ  ภาษาท่ี

เขียนน้ีเปนภาษา C อารดูโน ซ่ึงตัวอักษรเล็กใหญไมเหมือนกัน เชน a ไมเปนตัวเดียวกับ A  
 

 

ข้อระวงั การต่อวงจรผิด เช่น ต่ออปุกรณ์อิเล็คทรอนิคส์ สายไฟ(สายที�มีไฟเขา้) โดยไม่มีการต่อลง

กราวด์ จะทําใหบ้อร์ดพงัได ้  

LED ขายาวเป็น + ขาสั �นเป็น – หรือกราวด์ 
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ในตัวอยางน้ีกําหนดใหคาคงท่ีเทากับ 13 (เลขจํานวนเต็ม ตรงกับชนิดขอมูล int) ซึ่งตรงกับ ขาดิจิตอลท่ี D7 และตัว

แปรคาคงท่ีนี้จะนําไปใชไดกับฟงกชัน setup( ) และ loop( )  

 การกําหนดคาเร่ิมตน เพื่อระบุวา LED ขาท่ี 13 เปนผลลัพธ หรือท่ีใหไฟเขา ใหสังเกตวาจะเปนขายาว จะถูกกําหนด

ท่ี ฟงกชัน setup( ) และขาสั้นตอกับ GND  

สําหรับการทํางานซํ้าในฟงกชัน loop( ) เปนทําใหไฟ LED เปด-ปด โดยคําส่ังสําหรับให LED ติดไฟ และดับไฟ ใช 

การวัดแรงดันไฟฟาสูง ซ่ึงทําใหไฟติด หรือตํ่า ซ่ึงทําไฟดับ โดยเขียนดวยคําส่ัง digitalWrite( ) มีตัวแปรเขาเปน HIGH กับ LOW 

และถาหนวงเวลาไป 1 วินาทีก็ทําไดดวยกําหนด delay(1000) ดังตัวอยางท่ีผานมา การทํางานน้ีจะวนซํ้าไปเล่ือยๆ  
 

กฎของโอหม 

 เพ่ือทําความเขาใจเล็กนอย เก่ียวการไฟฟา ท่ีไหลในวงจรทํางานอยางไรกัน เพราะจะสวนสําคัญตอการใชงาน

อุปกรณอิเล็กทรอนิกส อยางนอยก็เพื่อเลือกใชงานไมเกิดความเสียหายได  

กอนอ่ืนใหนึกถึง ระบบนํ้าประปาท่ีบาน โดยเปรียบเทียบวา กระแสนํ้า ท่ีไหลตามทอ ปริมาณนํ้าท่ีไหลน้ัน

เปรียบเสมือนกระแสไฟฟา ซ่ึงมีหนวยวัดเปน แอมแปร (Amperes) หรือเรียกส้ันวา แอมป เทียบแรงดันนํ้าเปนแรงดันไฟฟา มี

หนวยเปน โวลต (Volt) และเทียบ ความตานทาน เปนเหมือนทอนํ้า มีหนวยเปน โอหม (Ohm) ใชสัญลักษณ Ω แทนหน่วยนี �

ได้  หลักการคํานวณ คาเหลาน้ี มีสูตรส้ันๆ วา  
 

V = I x R       (1) 
 

 โดยท่ี V แทนโวลต I แทนกระแส และ R แทน ความตานทาน เราจําเพียงสูตร (1) ก็พอ การหาคา I หรือ R ก็มาจาก

กลับไป-มาของสูตรน้ี ลองพิจารณาสูตรตอไปนี้ ท่ีมาจากการแปลงจากสูตรแรก 
 

I  = V / R      (2) 

R = V / I       (3) 
 

จากสูตร (1) น้ี ถาเพิ่ม กระแส (I) หรือ ความตานทาน (R) ก็จะทําให แรงดัน (V) สูงขึ้น เพราะเปนมาจากผลคูณของ

ตัวน้ี สําหรับสูตร (2) ถา ตองการให กระแส มีมาก ก็ตองใหตัวหาร (R) มีคานอยๆ หรือตัวถูกหาร (V) มีคามากๆ สําหรับสูตร 

(3) เราก็วิเคราะหในทํานองเดียวกัน   

 
 

หรือจะใชรูปสามเหลี่ยมแทนกฎของโอหมก็จะชวยใหจําไดงายขึ้น ตามรูปน้ี ถาใชหาคา V ก็ดูสวนลาง ไดผลเปน I x 

R ถาหาคา I ก็ใหดูรูปสวนขวา จะได V/R  
 

การท่ีไฟฟาลัดวงจร ท่ีอาจทําใหอุปกรณทดลองเสียหายได เน่ืองจาก R เปน 0 ทํา I มีคาสูงสุด  

หรือคา Infinity จากสูตร I = V/0 
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รูป 4. กฎสามเหลียมของโอหม 

 

ดังลองใหเปรียบเทียบระบบประปา ถาตองการใหน้ําไหลแรง เราก็ตองมีเคร่ืองปมนํ้า เปรียบไดกับ ถายไฟฉาย ท่ีเปน

ท่ีเก็บไฟฟา เพ่ือนํ้าไหลตอวินาทีแรงข้ึน ซ่ึงสงผลตอระบบอ่ืนๆ ดวย ท่ีตองรองรับความแรงของนํ้าได เชน ถาขอตอ ถาตอกันไม

ดี นํ้าอาจร่ัวได เชนเดียวกัน ในอุปกรณอิเล็กทรอนิกส อุปกรณตางๆ ที่รับแรงดันไฟสูงมากเกินพิกัดความสามรถ ถาไมไดทํามา

เพ่ือรองรับแรงดันไฟสูงได อาจทําใหอุปกรณน้ันเสียหายได นอกจากน้ี ปริมาณนํ้า หรือกระแสนํ้า ท่ีมีปริมาณมาก อาจทําให

อุปกรณทํางานตลอดเวลา ทําใหอาจอายุการงานส้ันลงได เหมือนกับหลอดไฟ หรือ LED ท่ีตอตรงกับบอรด Arduino หรือ 

NodeMcu ใหทํางานนานๆ อาจเสียหายได เราตองลดกระแสไฟลง วิธีการคือตองมี ตัวตานทาน ในระบบประปา มีกอกนํ้า ถา

เปดนอย นํ้าก็ไหลนอย ถาเปดมากนํ้าก็ไหลมาก รวมทอประปาก็ถือเปนตานทานอยางหน่ึงได ดังน้ันแลวจึงเปรียบเหมือนตัว

ตานทานใหนํ้าไหลไดมากหรือนอย ในวงจรไฟฟา มีอุปกรณท่ีทํางานในลักษณะน้ี คือ ตัวตานทาน (Resistor) ดังเพ่ือลด

กระแสไฟฟา ท่ีทํางานบน LED ไมใหทํางานท่ีปริมาณไฟมากเกินไป เหมือนหลอดไฟ ท่ีรับปริมาณไฟมากๆ อาจรอนไว และอายุ

การใชงานก็ส้ันลง เราจึงตองเพิ่มตัวตานทานเขาไปในวงจรเพื่อลดกระแสไฟฟา 

เชน การทดลองตอ LED ท่ีผานมา ใช การตอ โดยไมมีตัวตานใดคั้น ทําใหมีกระไฟฟาไหลผานเต็ม ท่ี ดังสูตรจากกฎ

ของโอหม V = IR ถาตองการหาคากระแส จะกลับสูตรเปน I = V/R ซ่ึงแปลไดวาย่ิงมีคา R สูง จะไดกระแสตํ่า และถาคา R ต่ํา

จะมีกระแสสูง จากสูตรน้ีเราสามารถนําไปคํานวณหาคา R ท่ีเหมาะสมท่ีใชกับ LED ได 
 

 
 

สําหรับบอรด NodeMcu จะใช GRD แทน กราวด หรือแทนการตอสายดิน หรือแทนข้ัวลบ และ พิน (PIN) ท่ีมี

แรงดันไฟ จะแทนขั้วบวก การไหลของกระแสไฟฟา ในวงจรอิเล็กทรอนิกส (แบบธรรมเนียมนิยม) จะไหลจากขั้วบวก ไปยังขั้ว

ลบ 
  

แบบฝกหัด 

1. ใหเขียนโปรแกรมให หลอด LED กระพริบ ทุกวินาที โดยใช LED-build-in (GPIO16) 

2. ใหเขียนโปรแกรมให หลอด LED สองตัว สลับกันติด-ดับ 

 

V 

R I 

ในกรณี การหา R ที�เหมาะสม เมื�อของ NodeMcu ไฟฟ้ามีแรงดนั 3.3 V และ LED ทั�วไปใช้แรงดนัฟ้าตกคล่อม

ประมาณเกนิ �.� V โดยใช้กระแสประมาณ �� mA ตวัต้านทาน ควร มีขนาด ��� โอห์ม คํานวณได้จากสูตร  

R = ( Vcc - Vf )/ If = (3.3-2.3)/0.02 = 50 โอหม 


